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Copyright © 1999 Nortel Networks, Inc.

All rights reserved. Printed in the USA. August 1999.

The information in this document is subject to change without notice. The statements, configurations, technica
and recommendations in this document are believed to be accurate and reliable, but are presented without ex
implied warranty. Users must take full responsibility for their applications of any products specified in this docu
The information in this document is proprietary to Nortel Networks, Inc.

The software described in this document is furnished under a license agreement and may only be used in acc
with the terms of that license. A summary of the Software License is included in this document. 

Trademarks

NORTEL NETWORKS is a trademark of Nortel Networks. Bay Networks and Optivity are registered trademark
Nortel Networks. Optivity Service Level Management, Optivity Service Level Help, Optivity Service Level Analy
VitalHelp for Optivity, VitalAnalysis for Optivity, VitalAgent for Optivity, and Optivity Network Management 
System (NMS) are trademarks of Nortel Networks, Inc.

VitalSigns, the VitalSigns logo, VitalAgent Automon, and Net.Medic are trademarks of INSoft Inc. Microsoft, 
Windows, Windows 95, Windows 98, Microsoft Excel, Microsoft Internet Explorer, and Windows NT are regist
trademarks of Microsoft Corporation. All other trademarks and registered trademarks are the property of their 
respective owners.

Restricted Rights Legend

Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subpa
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013.

Notwithstanding any other license agreement that may pertain to, or accompany the delivery of, this computer
software, the rights of the United States Government regarding its use, reproduction, and disclosure are as se
the Commercial Computer Software-Restricted Rights clause at FAR 52.227-19.

Statement of Conditions

In the interest of improving internal design, operational function, and/or reliability, Nortel Networks, Inc. reserve
right to make changes to the products described in this document without notice.

Nortel Networks, Inc. does not assume any liability that may occur due to the use or application of the produc
circuit layout(s) described herein.

Portions of the code in this software product are Copyright © 1988, Regents of the University of California. All 
reserved. Redistribution and use in source and binary forms of such portions are permitted, provided that the 
copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising m
and other materials related to such distribution and use acknowledge that such portions of the software were de
by the University of California, Berkeley. The name of the University may not be used to endorse or promote pr
derived from such portions of the software without specific prior written permission.

SUCH PORTIONS OF THE SOFTWARE ARE PROVIDED “AS IS” AND WITHOUT ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

In addition, the program and information contained herein are licensed only pursuant to a license agreement t
contains restrictions on use and disclosure (that may incorporate by reference certain limitations and notices i
by third parties).
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Nortel Networks, Inc. Optivity ® Network Management Software License Agreement

NOTICE:  Please carefully read this license agreement before copying or using the accompanying Optivity ne
management software or installing the hardware unit with pre-enabled Optivity network management software
of which is referred to as “Software” in this Agreement). BY COPYING OR USING THE SOFTWARE, YOU 
ACCEPT ALL OF THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT. THE TERMS 
EXPRESSED IN THIS AGREEMENT ARE THE ONLY TERMS UNDER WHICH NORTEL NETWORKS WILL
PERMIT YOU TO USE THE SOFTWARE. If you do not accept these terms and conditions, return the product
unused and in the original shipping container, within 30 days of purchase to obtain a credit for the full purchas

1. License Grant. Nortel Networks, Inc. (“Nortel Networks”) grants the end user of the Software (“Licensee”) a 
personal, nonexclusive license: a) to use the Software either on a single computer or, if applicable, on a single
authorized device identified by host ID; b) to copy the Software solely for backup purposes in support of autho
use of the Software; and c) to use and copy the associated user manual solely in support of authorized use of
Software by Licensee. This license applies to the Software only and does not extend to Nortel Networks Agen
software or other Nortel Networks software products. Nortel Networks Agent software or other Nortel Network
software products are licensed for use under the terms of the applicable Nortel Networks, Inc., Inc. Software L
Agreement that accompanies such software and upon payment by the end user of the applicable license fees
software. 

2. Restrictions on use; reservation of rights. The Software and user manuals are protected under copyright laws
Nortel Networks and/or its licensors retain all title and ownership in both the Software and user manuals, inclu
any revisions made by Nortel Networks or its licensors. The copyright notice must be reproduced and included
any copy of any portion of the Software or user manuals. Licensee may not modify, translate, decompile, disas
use for any competitive analysis, reverse engineer, distribute, or create derivative works from the Software or 
manuals or any copy, in whole or in part. Except as expressly provided in this Agreement, Licensee may not c
transfer the Software or user manuals, in whole or in part. The Software and user manuals embody Nortel Ne
and its licensors’ confidential and proprietary intellectual property. Licensee shall not disclose to any third part
Software, or any information about the operation, design, performance, or implementation of the Software and
manuals that is confidential to Nortel Networks and its licensors; however, Licensee may grant permission to i
consultants, subcontractors, and agents to use the Software at Licensee’s facility, provided they have agreed t
Software only in accordance with the terms of this license.

3. Limited warranty.  Nortel Networks warrants each item of Software, as delivered by Nortel Networks and prope
installed and operated on Nortel Networks hardware or other equipment it is originally licensed for, to function 
substantially as described in its accompanying user manual during its warranty period, which begins on the date S
is first shipped to Licensee. If any item of Software fails to so function during its warranty period, as the sole rem
Nortel Networks will at its discretion provide a suitable fix, patch, or workaround for the problem that may be incl
in a future Software release. Nortel Networks further warrants to Licensee that the media on which the Software
provided will be free from defects in materials and workmanship under normal use for a period of 90 days from th
the Software is first shipped to Licensee. Nortel Networks will replace defective media at no charge if it is returne
Nortel Networks during the warranty period along with proof of the date of shipment. This warranty does not apply
media has been damaged as a result of accident, misuse, or abuse. The Licensee assumes all responsibility for
of the Software to achieve Licensee’s intended results and for the installation, use, and results obtained from the
Software. Nortel Networks does not warrant a) that the functions contained in the software will meet the License
requirements, b) that the Software will operate in the hardware or software combinations that the Licensee may s
that the operation of the Software will be uninterrupted or error free, or d) that all defects in the operation of the So 
will be corrected. Nortel Networks is not obligated to remedy any Software defect that cannot be reproduced with
latest Software release. These warranties do not apply to the Software if it has been (i) altered, except by Nortel
Networks or in accordance with its instructions; (ii) used in conjunction with another vendor’s product, resulting in
defect; or (iii) damaged by improper environment, abuse, misuse, accident, or negligence. THE FOREGOING 
WARRANTIES AND LIMITATIONS ARE EXCLUSIVE REMEDIES AND ARE IN LIEU OF ALL OTHER 
WARRANTIES EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Licensee is responsible for the security of
own data and information and for maintaining adequate procedures apart from the Software to reconstruct lost o
files, data, or programs.
202336-D iii
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4. Limitation of liability.  IN NO EVENT WILL NORTEL NETWORKS OR ITS LICENSORS BE LIABLE FOR 
ANY COST OF SUBSTITUTE PROCUREMENT; SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES; OR ANY DAMAGES RESULTING FROM INACCURATE OR LOST DATA OR LOSS OF USE OR 
PROFITS ARISING OUT OF OR IN CONNECTION WITH THE PERFORMANCE OF THE SOFTWARE, EVE
IF NORTEL NETWORKS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT
SHALL THE LIABILITY OF NORTEL NETWORKS RELATING TO THE SOFTWARE OR THIS AGREEMENT 
EXCEED THE PRICE PAID TO NORTEL NETWORKS FOR THE SOFTWARE LICENSE.

5. Government Licensees. This provision applies to all Software and documentation acquired directly or indirectly
or on behalf of the United States Government. The Software and documentation are commercial products, lice
the open market at market prices, and were developed entirely at private expense and without the use of any 
Government funds. The license to the U.S. Government is granted only with restricted rights, and use, duplica
disclosure by the U.S. Government is subject to the restrictions set forth in subparagraph (c)(1) of the Comme
Computer Software––Restricted Rights clause of FAR 52.227-19 and the limitations set out in this license for c
agencies, and subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause of DFAR
252.227-7013, for agencies of the Department of Defense or their successors, whichever is applicable.

6. Use of Software in the European Community. This provision applies to all Software acquired for use within th
European Community. If Licensee uses the Software within a country in the European Community, the Softwa
Directive enacted by the Council of European Communities Directive dated 14 May, 1991, will apply to the 
examination of the Software to facilitate interoperability. Licensee agrees to notify Nortel Networks of any such
intended examination of the Software and may procure support and assistance from Nortel Networks.

7. Term and termination. This license is effective until terminated; however, all of the restrictions with respect to
Nortel Networks’ copyright in the Software and user manuals will cease being effective at the date of expiration
Nortel Networks copyright; those restrictions relating to use and disclosure of Nortel Networks’ confidential 
information shall continue in effect. Licensee may terminate this license at any time. The license will automatic
terminate if Licensee fails to comply with any of the terms and conditions of the license. Upon termination for a
reason, Licensee will immediately destroy or return to Nortel Networks the Software, user manuals, and all co
Nortel Networks is not liable to Licensee for damages in any form solely by reason of the termination of this lic

8. Export and Re-export. Licensee agrees not to export, directly or indirectly, the Software or related technical 
or information without first obtaining any required export licenses or other governmental approvals. Without lim
the foregoing, Licensee, on behalf of itself and its subsidiaries and affiliates, agrees that it will not, without firs
obtaining all export licenses and approvals required by the U.S. Government: (i) export, re-export, transfer, or 
any such Software or technical data, or any direct product thereof, to any country to which such exports or re-
are restricted or embargoed under United States export control laws and regulations, or to any national or res
such restricted or embargoed countries; or (ii) provide the Software or related technical data or information to 
military end user or for any military end use, including the design, development, or production of any chemical
nuclear, or biological weapons.

9. General. If any provision of this Agreement is held to be invalid or unenforceable by a court of competent 
jurisdiction, the remainder of the provisions of this Agreement shall remain in full force and effect. This Agreem
will be governed by the laws of the state of California.

Should you have any questions concerning this Agreement, contact Nortel Networks, 4401 Great America Pa
P.O. Box 58185, Santa Clara, California 95054-8185.

LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS AGREEMENT, UNDERSTANDS IT, AND 
AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. LICENSEE FURTHER AGREES THAT THIS 
AGREEMENT IS THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN NORTEL NETWORKS AND 
LICENSEE, WHICH SUPERSEDES ALL PRIOR ORAL AND WRITTEN AGREEMENTS AND 
COMMUNICATIONS BETWEEN THE PARTIES PERTAINING TO THE SUBJECT MATTER OF THIS 
AGREEMENT. NO DIFFERENT OR ADDITIONAL TERMS WILL BE ENFORCEABLE AGAINST NORTEL 
NETWORKS UNLESS NORTEL NETWORKS GIVES ITS EXPRESS WRITTEN CONSENT, INCLUDING AN
EXPRESS WAIVER OF THE TERMS OF THIS AGREEMENT.
iv 202336-D
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Introduction

These release notes describe issues and procedures related to Optivity Serv
Level Analysis™ Version 3.0. Information regarding VitalAgent for Optivity™, 
VitalAgent IT for Optivity™, and VitalAgent Automon for Optivity™ is included in 
this document.

Product Description

This section provides detailed information regarding the contents of your Opti
Service Level Analysis 3.0 product and describes current product features an
enhancements.

Package Contents

Your Optivity Service Level Analysis 3.0 product contains:

• Optivity Service Level Help 3.0 Software CD including:

— VitalAnalysis for Optivity server software

— VitalAgent for Optivity software

— VitalAgent IT for Optivity software

— VitalAgent Automon software

• Start Here/Registering Optivity Service Level Help 3.0 card, including the 
serial number of your product. Use this document and serial number to 
register your product to obtain a permanent license key. The temporary lic
key that ships with your product expires seven days after you install the 
software.

Note: In some documentation “Optivity Service Level Management” may be 
referred to as “OSLM” or “Optivity SLM.” “Optivity Service Level Analysis” 
may be referred to as “VitalAnalysis for Optivity,” and “Optivity Service 
Level Help” may be referred to as “VitalHelp for Optivity.” “Optivity SLM 
Agents” refers to VitalAgent for Optivity and VitalAgent IT for Optivity 
unless specified in the documentation.
202336-D 1
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• Getting Started with Optivity Service Level Analysis 3.0 (Bay Networks® part 
number 202338-C). Provides basic instructions for installing your 
VitalAnalysis for Optivity server software and deploying Optivity SLM 
agents.

• Optivity Service Level Management 3.0 Documentation CD (Bay Networks 
part number 205357-B), including:

— Installing and Administering Optivity Service Level Analysis 3.0—
Describes how to install, configure, and test VitalAnalysis for Optivity.

— Using Optivity Service Level Analysis 3.0—Describes how to use this 
service-level monitoring and capacity planning tool, based on aggrega
VitalAgent for Optivity, VitalAgent IT for Optivity, and VitalAgent 
Automon data.

— Using VitalAgent Automon for Optivity—Describes how to use this 
Optivity Service Level Management extension. This specialized agen
extension lets you generate synthetic transactions, independent of en
user actions.

— Installing and Administering Optivity Service Level Help 3.0—Describes 
how to install, configure, and test VitalHelp for Optivity.

— Using Optivity Service Level Help 3.0—Describes how to use the 
VitalHelp for Optivity fault management system.

New Features

This section provides an overview of the new features in Optivity Service Lev
Analysis 3.0.

• Monthly Views—You can now view VitalAnalysis for Optivity heat charts 
and reports on a daily, weekly, or monthly basis.

• SLA Violations—The new Service Level Agreements (SLAs) administration 
utility provides more granularity for defining SLAs. You can now set SLAs
beyond the application level, to the actual transaction level. For example,
can set an SLA threshold for POP3 login.

• Client List—A new Client List displays a summary list of all end-user 
desktops that have an Optivity SLM agent installed. Clients are listed by 
group. You can use the default groupings, or define specific groups, such as
users who are experiencing performance problems. Client lists provide agen
desktop configuration parameters and a list of active events per client.
2 202336-D



Product Description
  

tom 
t 

s and 

t 
el. 
 

 on 

tures 

ps.

 
P 

d 

.

ing 
ts 

 have 
• Grouping—You now have the flexibility to define your own customized 
groups, to streamline viewing of performance metrics. You can create cus
groups regardless of where the desktops are located, and define them by clien
name, IP address, network number, or host name. You cannot set policie
SLAs on a group basis.

• VitalAgent IT for Optivity—A feature-rich version of the standard VitalAgen
for Optivity, this agent is designed for information technology (IT) personn
Similar to VitalAgent for Optivity, VitalAgent IT for Optivity posts data to the
OSLM servers, allowing the IT administrator to view performance metrics
the VitalAgent IT for Optivity desktops. The agent provides granular 
performance statistics that are not available in VitalAgent for Optivity. 
You can run tests such as ICMP echo tests, trace routes, and packet cap
from the VitalAgent IT for Optivity desktop. These tests are limited to the 
local desktop. VitalAgent IT for Optivity cannot invoke other agent deskto

• Optivity SLM-SNMP Gateway

The Optivity SLM-SNMP Gateway application included with your Optivity
SLM base product allows you to integrate Optivity SLM software with SNM
management systems such as HP OpenView Network Node Manager an
Optivity Network Management System™ (NMS) 9.0. VitalAnalysis for 
Optivity automatically forwards events to your SNMP management system

• License Key Format—This release of Optivity SLM includes a new licens
format that provides more flexibility. You can purchase Optivity SLM agen
in specified quantities, to add to the agents you already have. Functionality of 
modules and add-ons is enabled or disabled based on the license key you
purchased. You must purchase a separate license key from International 
Network Services, Inc. (INS) to enable add-ons such as the Transaction 
Toolkit, DatabaseExpert Module, or Remedy Gateway.

Note: VitalAgent IT for Optivity counts for five VitalAgent for Optivity 
licenses. Refer to “License Key Tips” in Installing and Administering Optivity 
Service Level Analysis 3.0 for details.

Note: The Optivity SLM Email and SNMP Gateways are also known as the 
Email and SNMP Gateways in other Optivity SLM documentation. However, 
both gateways are specific to Optivity SLM.
202336-D 3
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Additional Features

This section provides an overview of VitalAnalysis for Optivity features.

• Optivity SLM-NMS Gateway—The integration of VitalAnalysis for Optivity
and Optivity NMS 9.0 provides detailed network transaction information fro
the end user viewpoint. This powerful combination of applications provides 
complete network traffic route tracing, from the end user to the server, prin
or other end device.

• Optivity SLM-Email Gateway, that provides:

— Automatic notification to help desk or IT personnel of events logged b
your VitalAnalysis for Optivity server.

— Automatic distribution of update messages from VitalAnalysis for 
Optivity events; for example, notifying personnel when an alarm is 
cleared.

— Creation of a workflow picture through heat charts and reports that ca
assist your help desk personnel in more timely problem resolutions.

• VitalAnalysis for Optivity has an extensive on-line Help system. To access
Help system, click Help or the question mark symbol (?) in any VitalAnaly
for Optivity window.

• Visibility of remote user activity is available, using enhanced remote acce
support. The following remote dial-up phases are monitored by VitalAgent for 
Optivity and reported to your Optivity SLM servers:

— Modem connection (checking for dial tone)

— Dialing the remote access number

— Handshaking

— Log in/authentication

— IP address negotiation

— Access to resources
4 202336-D
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• Optivity SLM supports numerous IP-based applications, such as:

— Email

— Groupware

— Enterprise Resource Planning (ERP)

— Database

— Multimedia

• You can specify master/subordinate servers to simplify the configuration a
administration of Optivity SLM servers in an environment where multiple 
Optivity SLM servers exist.

• You can deploy VitalAgent for Optivity on end-user desktops without user
interaction. For information refer to Chapter 4, “Configuring Optivity SLM 
Agents,” in Installing and Administering Optivity Service Level Help 3.0.

• The Path Trace™ feature of Optivity SLM provides further network 
information by linking to the Network Path Trace feature in the InfoCenter™ 
application of Optivity NMS 9.0. You must have at least version 9.0 of 
Optivity NMS to use this Optivity SLM-enabled feature. Do not enter an IP
address of an Optivity NMS Web server with a version earlier than Optivity 
NMS 9.0.

Use one of the following methods to enable the Path Trace feature:

— If you are installing VitalAnalysis for Optivity, enter the IP address of 
your Optivity NMS 9.0 Web server in the VitalAnalysis for Optivity 
Installation Welcome window.

— If you have already installed VitalAnalysis for Optivity you can enter th
Optivity NMS 9.0 Web server IP address in the VitalAnalysis for Optivi
Adminstration window.

1. Choose Server configuration > Server administration.

2. Enter the Optivity NMS 9.0 Web server IP address in the Optivity 
Web Server field.

3. Click Submit.
202336-D 5
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To start the Path Trace feature in VitalAnalysis for Optivity:

1. From the VitalAnalysis for Optivity console, choose Clients or 
Servers.

2. Click the diagonal Find Client or Find Server arrow to link to 
Optivity NMS 9.0 > Network Path Trace.

3. Enter the following login information for your Optivity NMS 9.0 Web 
server:

—User Name

—Password

—Host Name (or host IP address)

VitalAnalysis for Optivity Installation Notes and Instructions

This section provides helpful information about installing your product. If you 
upgrading from an earlier version of VitalAnalysis for Optivity, you should rea
the “Upgrade Notes and Instructions” on page 8 prior to installing the new 
version.

Preinstallation

Hardware and Software Requirements

Before starting the VitalAnalysis for Optivity installation, verify that your 
designated server meets the following requirements:
6 202336-D
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Table 1. System Requirements for the VitalAnalysis for Optivity Server

Requirement Description

Hardware A CPU, including:
• Pentium 200 MHz processor or greater 

(Pentium II 350 MHz processor is strongly recommended)*
• 128 megabytes (MB) of RAM minimum
A hard disk, including:
• 4 gigabytes (GB) of free space, for database storage

CD-ROM drive

LAN-based network connection with Microsoft TCP/IP and a fixed IP address

Video display with 1024 x 768 resolution

Software Windows NT 4.0 Server (or later) software, including:
• Microsoft Windows NT 4.0 Service Pack 3 (or later)
• Microsoft Excel® 97 (including Data Access Tools, Converters and Filters)
• Microsoft Windows NT® file system (NTFS) (recommended)

Open Database Connectivity (ODBC), at least version 3.51 (available on the 
Optivity Service Level Analysis 3.0 Software CD)

Administrator access to the Windows NT server

One of the following Internet browsers: 
• Netscape Navigator, version 4.04 minimum
• Microsoft Internet Explorer®, version 4.01 minimum, with Service Pack 1 (SP1)

* Production sites with more than 1,000 agent desktops reporting to a single VitalAnalysis for Optivity server may benefit from additional 
system capabilities. Nortel Networks strongly recommends a Pentium II 450 Mhz processor and 256 MB of RAM for these large 
production sites.

Note: Your VitalAnalysis for Optivity software functions properly with 
Windows NT 4.0 SP3. However, Nortel Networks recommends using 
Windows NT 4.0 SP4, or higher, to provide Year 2000 compliance of the 
Windows NT software.

Note: Your VitalAnalysis for Optivity software functions properly with 
Netscape Navigator 4.04. However, Nortel Networks recommends using 
Netscape Navigator 4.0.8 or Netscape Communicator 4.5.1, or higher, to 
ensure compatibility with Optivity NMS 9.0.
202336-D 7
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• Nortel Networks recommends running VitalAnalysis for Optivity on a 
dedicated server, separate from the VitalHelp for Optivity server.

• Do not install Optivity NMS 9.0 on the same server as VitalAnalysis for 
Optivity or VitalHelp for Optivity.

Registering Your Product

You must register your VitalAnalysis for Optivity software to obtain a permane
server license key. The temporary license key that shipped with your software
expires in seven days. Follow the instructions on the Start Here/Registering 
Optivity Service Level Help 3.0 card that shipped with your software. This card 
includes your product serial number which is required when registering. You m
register your VitalAnalysis for Optivity and VitalHelp for Optivity software 
separately.

Your servers must have static IP addresses prior to registering and obtaining
permanent license key.

Upgrade Notes and Instructions

If you are upgrading from an earlier version of VitalAnalysis for Optivity:

• The VitalAnalysis for Optivity 3.0 database is not compatible with previou
versions. You must update your existing database for VitalAnalysis for 
Optivity to run properly. If you no longer require the information in your 
current database, you may choose to eliminate it. During the VitalAnalysis
Optivity custom installation process you are prompted to leave, or replace
your database. The Express Install program automatically upgrades the 
existing database, without asking you.

Nortel Networks recommends that you back up the VitalAnalysis for Optiv
database prior to upgrading your product.
8 202336-D
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To back up existing database files:

1. Shut down the VitalSuiteDB service.

2. Copy the database files into a backup directory.

Existing database files are typically located in the 
<drive>:\ProgramFiles\VitalHelp\Data directory.

After you have upgraded your current VitalAnalysis for Optivity software a
the associated database, copy the new database and place it in a backup
directory. This process ensures that you have a compatible database, wh
includes your previous data, available if system corruption should occur.

• Shut down all VitalAnalysis for Optivity executables such as the 
VitalSuiteWeb and VitalSuiteDB services. Use the Windows Task Manage
end any vhrpt, vhcgi, and vscgi programs.

• To successfully upgrade to VitalAnalysis for Optivity 3.0, your server mus
have at least twice as much disk space as it is currently using for the current 
database. For example, if your current database is using 1GB of available
space, your new database will require 2GB.

• Nortel Networks recommends that you change the 
web_disk_space_check_interval registry variable from 3600 to 300, using the
Registry editor. Changing this variable results in the Web server checking
disk space every five minutes.

• You can configure secure access to your VitalAnalysis for Optivity server 
generating your reports from another Web server. If you configured a 
third-party Web server to provide your VitalAnalysis for Optivity Web page
you must reconfigure the third-party Web server port registry variable whe
you upgrade to a new version of VitalAnalysis for Optivity. This enables lin
between your VitalAnalysis for Optivity and VitalHelp for Optivity servers, a
well as links from the VitalHelp Windows Console for Optivity.

For VitalAnalysis for Optivity 3.0, you need to define two new variables in
different location. After upgrading from an earlier version of VitalAnalysis f
Optivity, reconfigure the third-party Web port registry variables. Refer to 
Appendix A, “Using Third-Party Web Servers” in Installing and 
Administering Optivity Service Level Analysis 3.0 for details.

• If you are using Microsoft Internet Explorer or Netscape to provide report
and you click Server configuration > Server status in the VitalAnalysis for
Optivity Administration page, you will receive an HTTP error 404.
202336-D 9



Release Notes for Optivity Service Level Analysis Version 3.0

ty 
on is 

ou 

may 
To correct this error and view server status:

1. Go to the Program Files\VSCommon\webroot\VAAdmin\html 
directory.

2. Make a backup copy of the vaConfMenu.htm file.

3. Use a text editor such as Notepad to make the following changes to 
the vaConfMenu.htm file:

a. Search for the “/stats” string. 

There should be only one occurrence of this string.

b. Modify the “/stats” string to “http://< ipaddress>:<port>/stats”

Where <ipaddress> is the IP address and <port> is the port number 
of the VitalAnalysis for Optivity server. For example, specify 
http://1.2.3.4:2474/stats if the IP address is 1.2.3.4 and the port 
is 2474.

c. In the VitalAnalysis for Optivity Administration page, click 
Server configuration > Server status.

If you are using a third-party Web server to display VitalAnalysis for Optivi
heat charts, reports and administration pages, the server status informati
not available.

• Some SLA threshold values in VitalAnalysis for Optivity 3.0 are given in 
milliseconds, as opposed to percentages as in previous versions. When y
upgrade your server software, existing SLA threshold percentages are 
multiplied by 100 to calculate the values in milliseconds.

To view the new SLA threshold values:

— From the VitalAnalysis for Optivity Administration page, click SLA 
Thresholds and make any necessary changes.

• You may see application names listed in heat charts, but heat chart cells 
not be currently filled with a dot for that application. A delay of up to two 
hours may occur until data is aggregated and displayed.
10 202336-D
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• In most cases, the group name and ID values of existing group definitions
converted when you upgrade. Group ID values 1 to 1000 are reversed wh
you upgrade and are not preserved. This range of values applies to class
network numbers such as n.0.0.0. If you created aliases for such groups 
previously, you need to redefine those groups after the upgrade.

• If you have VitalHelp for Optivity and VitalAnalysis for Optivity installed 
on the same server, and you want to upgrade both products, upgrade 
VitalAnalysis for Optivity first, and then upgrade VitalHelp for Optivity.

• To upgrade your VitalAnalysis for Optivity server:

1. In the VitalAnalysis for Optivity Server Configuration dialog box, 
click OK to accept the defaults, or customize the defaults as needed.

The VitalAnalysis for Optivity Install program reports that files are being 
copied. Your current VitalAnalysis for Optivity settings are maintained
during the upgrade.

The Install program checks that your VitalAnalysis for Optivity server h
all of the necessary Microsoft Excel 97 components.

2. If you receive a message that you must install any Microsoft Excel 97
components, click OK. Install the required components after your 
VitalAnalysis for Optivity installation is complete.

3. At the prompt to leave or replace your existing database:

a. Click Replace to remove the existing services, including the 
database. New VitalAnalysis for Optivity services are installed to 
ensure that user account information is current.

b. Click OK to remove and reinstall the VitalAnalysis for Optivity 
services.

4. When prompted, enter the name of your e-mail server.

5. If you did not upgrade or replace your database, you receive a 
prompt indicating that the database requires upgrading.
202336-D 11
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6. Click OK.

A dialog box asks if you want to immediately start the following service
VitalAnalysis for Optivity, VitalSuiteWeb, and VitalSuiteDB.

— Click Start to immediately start the VitalAnalysis for Optivity 
services without rebooting the VitalAnalysis for Optivity server.

A command prompt window reports that the VitalAnalysis for 
Optivity services have been started.

OR

— Click Skip if you want to start the services manually. Refer to 
Chapter 7, “Manually Starting and Stopping the Database and We
Server Services” in Installing and Administering Optivity Service 
Level Analysis 3.0 for instructions.

The Install program reports that VitalAnalysis for Optivity is installed.

7. Click Finish.

• VitalAgent for Optivity 2.0 or 2.1 does not recognize any changes that you
make to your application definition files in the VitalAnalysis for Optivity 3.0
Administration page. If you do not plan to update all of your VitalAgents fo
Optivity immediately, make sure the application definitions are correct in y
current version of VitalAnalysis for Optivity before you upgrade to 
VitalAnalysis for Optivity 3.0 server software.

To view or modify the application definitions:

1. From the VitalAnalysis for Optivity Administration page, click 
Agent Configuration > Application definition.

2. Modify the applications being monitored, as needed.

When you upgrade the agent, it starts monitoring applications as defined
the VitalAnalysis for Optivity 3.0 server.
12 202336-D
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Installation Notes

The following installation notes provide information for installing your 
VitalAnalysis for Optivity software.

• When you install VitalAnalysis for Optivity, you may receive an error 
message indicating that there is not enough disk space to install the databas
software. If you are certain that the designated server has a sufficient am
of disk space to install the software, ignore this error message and contin
with the installation.

• Database Cache Size

You can specify the database cache size during a custom installation of 
VitalAnalysis for Optivity. The default database cache size is 24 MB. If you
want to change the cache size you must use an integer (or whole numbe
For instance, change the cache size to 48 MB not 48.5 MB.

• Installation Error Message

When you are installing VitalAnalysis for Optivity you may receive a messa
indicating that there is not enough memory to install the database software
you are sure that your designated VitalAnalysis for Optivity server has a 
sufficient amount on memory to install the database, ignore the error mes
and continue with the installation process.

• VitalAgent for Optivity and Net.Medic

— Before installing VitalAgent for Optivity, make sure that any existing 
version of VitalAgent for Optivity or Net.Medic on the desktop is shut 
down. To shut down VitalAgent for Optivity, or the Net.Medic program
right-click the cross icon in the Windows system tray and choose Exit
from the pop-up menu. 

— You cannot run VitalAgent for Optivity and Net.Medic on the same 
workstation. 

— Clients running Net.Medic 1.2 or later are able to discover the 
VitalAnalysis for Optivity workstation if the workstation is named 
“vitalconnect.” However, uploading data from these clients is not 
recommended because such data is dropped and/or discarded on the
VitalAnalysis for Optivity server. Instead, if you find a client with 
Net.Medic, update them to the latest version of VitalAgent for Optivity
to ensure full support for VitalAnalysis for Optivity.
202336-D 13



Release Notes for Optivity Service Level Analysis Version 3.0

t 
he 

(*). 
ter 
se 

h 
• You cannot disable VitalAgent for Optivity for the following applications: 
NetShow, Pointcast, and RealPlayer.

• If you need to uninstall VitalAnalysis for Optivity:

1. From the Windows taskbar, choose Start > Settings > Control Panel > 
Add/Remove.

2. Select VitalAnalysis for Optivity.

3. Click Add/Remove.

General Notes

This section provides general notes about the following topics:

• “Administration,” next

• “Heat Charts and Reports,” on page 19

Administration

• Adding Custom Applications, Servers, Clients, and Subnet Aliases

— When you add the names of applications, servers, clients, and subne
aliases, you must not use an ampersand (&) or an equals sign (=) in t
name. Alphanumeric characters are recommended.

— When you define custom groups, you can use the wildcard character 
However, for IP addresses and network numbers, the wildcard charac
can only occur at the end of the group name. For example, you can u
a.b.c.* or a.b.*.*, but not a.*.b.c.

— When you add custom applications for monitoring, more than one 
application defined with exactly the same Application Definition form 
entries results in incorrect monitoring of the application. Be sure that eac
application defined is unique in some way, for example by server IP 
address or port number.
14 202336-D
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• Database Backups

VitalAnalysis for Optivity comes with a commercial run-time third-party 
database. This database is backed up automatically on a weekly basis, 
depending on the option you choose during installation. You can choose 
incremental, or no backup.

If a weekly backup is not adequate, and you want more frequent backups
the SYBASE DBBACKUP utility to create your own backup schedule. Ref
to the SQLAnywhere online documentation.

• Application Comparison and Client Health Reports

You could have difficulties with the Application Comparison and/or Client 
Health reports where some of the labels on the x-axis are dropped. This 
happens if there are very large values on the y-axis, or if you have long 
application or server names on the x-axis that wrap to two lines.

To solve this problem, you can change the default topN value 
(thirdArgDefault.8=15) from 15 to a smaller value. For example, change t
value to thirdArgDefault.8=10. You can change this value manually by edit
the <drive>:\Program Files\VitalAnalysis\reports\rptlist.txt file.

• Simplified Administration

Administration and configuration for customers with multiple VitalAnalysis
for Optivity and VitalHelp for Optivity servers has been simplified. From th
Administration page of either server, click Server configuration > Master 
config.

The administrator can:

— Designate each server as a master or subordinate server

— Set common policy parameters on the master server

— Automatically send (push) policy changes to each subordinate server
real time.

Note that the VitalAnalysis for Optivity and VitalHelp for Optivity specific 
configuration information cannot be shared and must be specified on eac
server. For example, you must change the server license key, upload targ
configuration target on the VitalAnalysis for Optivity server in order for the
changes to affect that server.

For more details refer to Installing and Administering Optivity Service Level
Analysis 3.0 or Installing and Administering Optivity Service Level Help 3.0.
202336-D 15
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• Disabling the VitalAnalysis for Optivity Web Server’s Ability to Provide 
VitalAnalysis for Optivity Web Pages

The VitalAnalysis for Optivity product is shipped with a Web server that is
automatically installed as part of the VitalAnalysis for Optivity installation.
If you want to password protect your VitalAnalysis for Optivity reporting 
interface or configuration/administration pages, you can use another Web
server (for example, a Microsoft Internet Information Server or Netscape 
Enterprise Server) to deliver these VitalAnalysis for Optivity pages.

If you plan to use a third-party Web server to serve the VitalAnalysis for 
Optivity Web pages you must disable the default Web server from delivering 
these Web pages. To disable the default Web server, set the 
HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Services/
VitalSignsWeb/Parameters/NO_REPORTS variable to “1”. This is a *String* 
registry variable that disables the Web server with a value of “1”, and ena
it with a value of “0.”

Note that you must use a registry variable because the Web server does 
have a Web form for disabling the reports/administration interface. You must 
restart the Web server for any change to this variable to take effect.

If you inadvertently disabled the reports/administration interface and do not 
have a third-party Web server to turn it back on, you can re-enable it by setting 
the HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Services/
VitalSignsWeb/Parameters/NO_REPORTS variable to “0.”

• Enabling the Allow Service to Interact with Desktop Option

Nortel Networks recommends that you enable the Allow Service to Interact 
with Desktop option. To enable this option: 

1. From the Windows taskbar, choose Start > Settings > Control Panel.

2. In the displayed Control Panel, double-click Services.

3. In the displayed Services dialog box, double-click VitalSuiteWeb 
service.

4. In the displayed Service dialog box, choose the Allow Service to 
Interact with Desktop option and click OK.
16 202336-D
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• Rebooting the VitalAnalysis for Optivity Server

If you want to reboot your VitalAnalysis for Optivity server, from the 
Windows task bar choose Start > Settings > Control Panel. Double-click 
Services and stop the VitalAnalysis for Optivity, VitalSuite database, and 
VitalSuiteWeb services. Then start up these three services again.

• Reviewing Log Files

Periodically review the log files in the \VSCommon\webroot\logs directory. (In 
most cases, the directory is the \Program Files directory, where you installed 
VitalAnalysis for Optivity.) After you review the contents of the VitalAnalysi
for Optivity log files, you should delete the ones you do not want to keep.
Note that a new VitalAnalysis for Optivity database log file is created ever
day.

• Running Multiple Optivity SLM Servers 

If you have multiple Optivity SLM servers in your enterprise and you want
them to share common Optivity SLM agents, you must designate one of y
VitalAnalysis for Optivity or VitalHelp for Optivity servers as the master 
server. All your other Optivity SLM servers should be designated as 
subordinate servers. 

By setting up master/subordinate servers, all of your VitalAgent for Optivi
desktops go to the master server for the following master policies:

— The application definition list that controls which applications the 
Optivity SLM agents monitor. 

— The Optivity SLM agent download pages to guarantee that at any one 
time all your users are downloading the same agent version.

— Server filters and URL categories that control which servers and URL
the VitalAgent for Optivity monitor. 

— User interface policies for VitalAgent for Optivity that specify the 
VitalAgent for Optivity user interface on your end users’ desktops. 

— Software update information to ensure that all of your VitalAgent for 
Optivity desktops are running the latest version of the VitalAgent for 
Optivity software.
202336-D 17
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All of the Optivity SLM servers, that are included in your list of subordinat
servers, automatically receive the application definition list from the maste
server. However, that if you want to add another Optivity SLM server to yo
list of subordinate servers at a later date, you should configure an applica
definition list on that particular server. This application definition list shoul
be identical to the one that currently exists on your master server. This 
practice ensures that all of your subordinate servers are using the same 
application definition list regardless of when they were installed in the 
enterprise.

Nortel Networks recommends that you designate your VitalAnalysis for 
Optivity as the master server and your VitalHelp for Optivity as the 
subordinate server.

Configuration information specific to VitalAnalysis for Optivity and 
VitalHelp for Optivity (for example, the server license key) cannot be shar
and must be specified on each particular server. For example, you must us
VitalHelp for Optivity Web page or the VitalAnalysis for Optivity Web page
to view or modify the license key for the VitalHelp for Optivity or 
VitalAnalysis for Optivity server.

• Upload Target Field Display Limit

As part of configuring your VitalAnalysis for Optivity server, you must 
specify the VitalAnalysis for Optivity server that your Optivity SLM agents
check for uploading data. When you install VitalAnalysis for Optivity, the 
maximum number of characters that you can enter in the Upload Target f
is 40. After the software installation you can specify values greater than 4

• vcc -F Command

When you use the vcc -F command to upload Optivity SLM agent test dat
the VitalAnalysis for Optivity server, only data collected prior to the 
preceding hour is uploaded. For example, if you execute this command at
p.m., only data collected prior to 3:00 p.m. is sent to the server. Data colle
between 3:00 p.m. and 3:59 p.m. is not available for viewing until after 
4:00 p.m and cannot be viewed in the VitalAnalysis for Optivity reports un
the server aggregation delay has elapsed.
18 202336-D
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• Viewing VitalAnalysis for Optivity Web Server Status

You can view the status of your VitalAnalysis for Optivity Web server by 
clicking the server status link in the VitalAnalysis for Optivity Administratio
page. If you are using a third-party Web server to display your VitalAnalys
for Optivity Web pages (heat charts, reports, and administration pages), t
server status information is not available.

• Working with the VitalAnalysis for Optivity Web Interface 

Due to the manner in which the VitalAnalysis for Optivity heat charts and 
administrative pages use frames, Nortel Networks recommends that you 
not use the browser’s BACK and FORWARD buttons.

• Running VitalAnalysis for Optivity Through a Firewall

To run VitalAnalysis for Optivity through a firewall, configure the check po
(80 or 2474) to be open.

Heat Charts and Reports 

• Application Comparison Report 

An Application Comparison report is only available for the prior day.

• Microsoft Excel 97 Requirements 

You must have all of the Microsoft Excel 97 components, including the Da
Access Tools and the Converters and Filters programs, and their 
sub-components, installed to view VitalAnalysis for Optivity heat charts an
reports. Excel must be installed under an administrator account that has 
access to the \Program Files\VSCommon directory.

• Obtaining More Information about Heat Charts and Reports

You can use VitalAnalysis for Optivity to create, view, and print heat chart
and reports about your aggregated VitalAgent for Optivity data. To display
information about each VitalAnalysis for Optivity heat chart and report, cli
Help on any heat chart or report page.
202336-D 19
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• Printing Reports

— The pages you print by clicking the Print icon on the report page are 
formatted on the VitalAnalysis for Optivity server, producing better 
quality output.

— When a VitalAnalysis for Optivity user prints a report using the browse
print feature, the output is sent to the default printer on the browser 
workstation.

— When a VitalAnalysis for Optivity user prints a report using the Print ic
on a report page, the report is regenerated and sent to the default pri
for the VitalAnalysis for Optivity server. The System account of the ser
may not have a printer configured. If so, you can use one of the follow
methods to enable printing with the Print icon:

– Change the account under which the VitalAnalysis for Optivity We
server runs

– Add a local printer as the default printer for the system account

If you reinstall VitalAnalysis for Optivity, you must repeat the process 
enabling the Print icon.

— If a VitalAnalysis for Optivity user clicks the Print icon on a report pag
and the VitalAnalysis for Optivity administrator has not set up the prin
capability, the report is not printed and an Excel process is created. Y
cannot stop this kind of Excel process unless you restart the 
VitalSuiteWeb server. For instructions on how to set up the print 
capability for your VitalAnalysis for Optivity reports, refer to Chapter 3
“Using the VitalAnalysis Heat Charts and Reports,” in Using Optivity 
Service Level Analysis 3.0.

— If you experience problems printing from the Netscape browser:

1. Verify that the Black text option is selected in your Page Setup 
dialog box.

2. Right-click the frame that contains the actual report (graphs and 
tables), and use the displayed pop-up menu to print the report.

— Excel reports may not run on some PCs because of a Microsoft® bug 
related to OLE’s handling of file path names. OLE stops at the embed
space and searches the incorrect directory for the excel.exe file. To avoid 
this bug, be sure that the \Program Files\Microsoft\ directory does not 
exist.
20 202336-D



VitalAnalysis for Optivity Installation Notes and Instructions
  

o 

 

lus 

e 

For 
.m. is 

 
you 
m. 
red 
 

• Reports Show “No Answer” as “No Carrier”

Many modems cannot distinguish between “no carrier” and “no answers”. 
Therefore, VitalAnalysis for Optivity may report no answer as no carrier.

• Modem reports Show “No Dial Tone Numbers” as “UNKNOWN”

If Optivity SLM agents report no dial tone, the number field displays 
“UNKNOWN”.

• VitalAgent for Optivity Call Log Reports Show “Time to login” as “Time to 
communicate”

The VitalAgent for Optivity call log “time to login” is reported as the “time t
communicate” in the VitalAnalysis for Optivity modem reports.

• Regenerating Heat Charts 

The date that the heat chart was generated is displayed at the top of a heat 
chart. After checking this date, you may need to regenerate a heat chart 
depending on the aggregation delay. To regenerate a heat chart, click the
Regenerate icon in the heat chart.

If your heat charts do not display data:

— Regenerate the heat chart after waiting the aggregation delay time, p
one hour.

— Verify that the browser cache is set to reload pages each time they ar
accessed.

Uploaded data is aggregated two hours after it is stored in the database. 
example, data uploaded into the database between 12:00 p.m. and 1:00 a
automatically aggregated between 3:00 a.m. and 4:00 a.m. You can use 
VitalAnalysis for Optivity to change the aggregation delay.

• Restoring Missing .GIF Files on Heat Charts

If you are reinstalling VitalAnalysis for Optivity, the icon for a missing GIF
file may appear in all of your previously generated heat charts. However, 
can quickly restore the graphics on these heat charts by regenerating the
Click Regenerate on in the heat chart. Because the missing GIFs are sha
between heat charts, you only have to regenerate a few charts in order to
restore the graphics in all of the heat charts.
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• Zero Connection Counts in Certain Heat Charts

The End to End Detailed heat charts and the Server heat charts for certa
application, such as Microsoft Exchange, will always show zero connectio
counts. This is due to the dynamic nature of the port numbers used by th
application. In the case of DNS applications, zero connection counts are 
always shown due to the connectionless UDP protocol.

• Modem Data

If the VitalAnalysis for Optivity heat charts do not display modem data, yo
may need to lengthen the aggregation period to accommodate the frequency 
of VitalAgent for Optivity uploads.

• You cannot disable VitalAgent for Optivity monitoring for the following 
applications: FTP, E-mail, SAP R/3, Web, or Web Secure.

Optivity SLM Agent Notes and Instructions

Preinstallation

• Hardware and Software Requirements

End-user desktops which will run Optivity SLM agents must meet the 
following requirements:

— An Ethernet, token ring, or dial-up network connection (modem and 
ISDN) for approved vendors

— Windows® 32-bit operating system (Windows NT 4.0, Windows 95®, or 
Windows 98®)

— 24 MB of RAM

— 2 MB of free disk space 

— A Pentium processor 

Note: Your VitalHelp for Optivity software functions properly with 
Windows 95 and Windows NT 4.0 SP3.
Nortel Networks recommends using Windows 95B and Windows NT 4.0 SP4
or higher, to provide Year 2000 compliance of the operating system.
22 202336-D
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• Before installing VitalAgent for Optivity, shut down the following:

— Internet browsers

— Anti-virus programs

— Existing versions of VitalAgent for Optivity, VitalAgent IT for Optivity, 
or Net.Medic on the desktop.

To shut down these agents, right-click the cross icon in the Windows 
system tray and choose Exit from the pop-up menu.

• Downloading VitalAgent for Optivity

Users can download the VitalAgent for Optivity software to their desktops
from http://<vitalhelp_server>default.htm. Click Download Now and follow 
the instructions.

• Downloading VitalAgent IT for Optivity

Users can download the VitalAgent IT for Optivity software to their desktops 
from http://<vitalhelp_server>vagentit.htm. Click Download Now and follow 
the instructions.

General Notes

• Proxies

VitalAgent for Optivity is designed to provide support for most intranet pro
server environments. The agent characterizes the environment between 
browser and the proxy server. 

From the VitalAgent for Optivity dashboard choose:

— View > Delay Pane to see Proxy delay information

— View > Activity Pane to see Proxy server information

• ISP Demarcation

You may not receive complete ISP demarcation if your ISP has not entere
names of ISP routers into the DNS server table.

• VitalAgent for Optivity Icon Color

VitalAgent for Optivity records information about serious errors occurring 
with your online connections. If an error occurred within the past two 
minutes, the icon turns red. You can click the red icon to display the diagn
window related to the problem.
202336-D 23
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• Server Communication

If your VitalAgent for Optivity desktops are not communicating with the 
VitalAnalysis for Optivity or VitalHelp for Optivity server:

— Verify that the VitalHelp for Optivity server target is set on the 
VitalAnalysis for Optivity server.

— Verify that the VitalAnalysis for Optivity server target is set on the 
VitalHelp for Optivity server using the VitalHelp Windows Console for 
Optivity.

— Verify that the server license key has not expired.

VitalAgent for Optivity only posts data to VitalAnalysis for Optivity and 
VitalHelp for Optivity servers if both servers are specified.

• Net.Medic

— You cannot run VitalAgent for Optivity and Net.Medic on the same 
end-user desktop, also known as a client.

— Clients running Net.Medic 1.2 or later are able to discover the VitalHe
for Optivity server if the server name is VitalHelp. However, uploading
data from these clients is not recommended. Instead, if you find a clie
with Net.Medic, update them to the latest version of VitalAgent for 
Optivity to ensure full support for VitalHelp for Optivity.

• If applications that you expect to see are not displayed:

— Check that the server filters are in place.

— Check that the applications to be monitored are enabled and properly
defined in the server Administration page.

• VitalAgent for Optivity works best with the Microsoft TCP/IP stack. Other 
network interfaces could cause problems.

• If you are having problems with uploading information from VitalAgent for
Optivity, check the vcclog.txt file to enable logging.

• If VitalAgent for Optivity events are not uploading, press [Alt] + [F8] on the
VitalAgent for Optivity desktop to verify the filter status. The status must b
“successful” or “no change” before events are uploaded properly.

• VitalAgent for Optivity has an extensive online Help system. To access th
Help system, right-click the VitalAgent for Optivity cross icon in the 
Windows system tray and choose VitalAgent for Optivity Help from the 
pop-up menu.
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VitalAgent Automon Notes

• If you specified dial-out prefix settings on Windows NT, VitalAgent Automon 
does not recognize them. You must specify the entire phone number for t
dial-up connection. For example, if your company telephone system requ
that you include a “9” prior to making local calls, add the “9” to the phone
number.

Use one of the following methods to specify the dial-up phone number:

— Use the VitalAgent Automon Configuration dialog box to specify the 
entire phone number for a VitalAgent Automon dial-up test.

— From the Windows taskbar, choose Start > Programs > Accessories >
Dial-up Network > Phonebook entry > Phone number.

• If you install VitalAgent Automon on a desktop that does not have Micros
Internet Explorer (at least version 4.01) installed, you may receive an erro
message and your Web server may not display URLs.

• Place the remote scripts in the \VSCommon\webroot\Automon directory on 
your Optivity SLM server.

• VitalAgent Automon only works on desktops that already have VitalAgent 
Optivity or VitalAgent IT for Optivity installed. VitalAgent for Optivity 
monitors and posts data to the server.

Known Problems

Known problems and operational issues for the VitalAnalysis for Optivity serv
software, Optivity SLM agents, and VitalAgent Automon are described in the 
following sections.

VitalAnalysis for Optivity

The following problems are known to exist in VitalAnalysis for Optivity:

• Remote DNS Lookup Tests

VitalHelp for Optivity performs remote DNS lookup tests on the VitalHelp f
Optivity server or on another system, such as a VitalHelp Client for Optivi
system. Remote tests such as the DNS lookup test should originate from
VitalAgent for Optivity desktop, not the server or other system. If your 
202336-D 25
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VitalAgent for Optivity desktops are located in a private network, the DNS
names may be resolved by the internal intranet address or the external N
address of each desktop. Therefore, inconsistent data results when such test
are not run directly from the VitalAgent for Optivity desktop.

To work around this problem:

1. Perform a DNS lookup test from the agent desktop.

The agent will provide correct DNS resolution data from the end-user
desktop.

2. Use the output of this DNS lookup test to perform TCP connect, 
ICMP Echo, Trace Route, or other remote tests.

• Documentation URL Correction

The correct URL for OSLM technical and online documentation is 
http://support.baynetworks.com/library/tpubs/oslm/index.html. Some 
references to this Web site may omit the last “l” (of “HTML”) in the URL.

• POP Errors

You may receive several, separate, entries for POP errors in Modem hea
charts and reports. For instance, the telephone number (408)495-0000 m
appear with other dialout prefixes or commas included, in addition to the 
actual number. This situation is caused by a large number of separate PO
categories.

• DNS Summary and Email Details Reports 

There is the possibility that the error graphs in the DNS Summary and Em
Detail reports may not have any data if the base table in the database has
purged. All other graphs use data from the aggregate tables.

• Historical Averages in VitalAnalysis for Optivity Reports 

Historical averages in the VitalAnalysis for Optivity reports may be under 
reported when there are fewer historical records in the database than the
number of historical days or weeks being reported. This situation only occ
when VitalAnalysis for Optivity has been installed for less than seven day
(daily reports) or 28 days (weekly reports) or there are complete days or 
weeks for which VitalAgent for Optivity data was not uploaded. 
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• Microsoft Excel

A non-U.S. version of Excel may not be detected correctly during the 
VitalAnalysis for Optivity installation. Consequently, the VitalAnalysis for 
Optivity Install program may warn you of missing Excel components even
they are installed correctly.

• Hung vcrpt and/or Excel Processes

Under certain error conditions, vcrpt and/or Excel processes may be left in 
hung state. If your VitalAnalysis for Optivity workstation experiences this 
problem, stop the hung processes or reboot the workstation, then turn on
Allow Service to Interact with Desktop option. 

To enable this option: 

1. From the Windows taskbar, choose Start > Settings > Control Panel.

2. In the displayed Control Panel, double-click Services.

3. In the displayed Services dialog box, double-click VitalSuiteWeb.

4. In the displayed Service dialog box, choose the Allow Service to 
Interact with Desktop option and click OK. 

• VitalAgent for Optivity

— With VitalAgent for Optivity, when you reboot Windows NT the 
following error message is placed in the Windows NT Event Viewer:

“The VitalSuite Serial Port Driver service failed to start due to the 
following error: The system cannot find the file specified.”

Ignore this message. The VitalAgent for Optivity software installs 
correctly.

• Browsers

— You may experience intermittent JAVA script errors if using Netscape 
Navigator 4.04. These can occur in any area of VitalAnalysis for Optivity.
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— If Microsoft Internet Explorer or Netscape Web servers are already 
installed on your Optivity SLM servers, VitalAnalysis for Optivity will be
installed on TCP port 2474, not the default port 80.

If this is the case, you must include the port number in the URL each t
you access VitalAnalysis for Optivity. For instance, use the following 
URLs:

– http://<vitalanalysis>:2474/vaconsole

– http://<vitalanalysis>:2474/vaadmin

— When displaying reports within the browser, report headings and colu
headings are truncated and are not displayed correctly. Sometimes 
changing the font size or minimizing the screen corrects the problem.

— The BACK button may not be supported in earlier versions of Netscape 
Navigator and Microsoft Internet Explorer. You may receive error 
messages; “Empty page” or “data not found.”

Optivity SLM Agents and VitalAgent Automon

The following problems are known to exist in VitalAgent for Optivity, VitalAgen
IT for Optivity, or VitalAgent Automon:

• Closing the VitalAgent Automon Window

You cannot use the “Close” option or the “x” in the upper right corner of th
VitalAgent Automon window to close the program.

To work around this problem:

Select File > Exit.

• VitalAgent for Optivity Interface Issues

— If you are using the VitalAgent for Optivity version that does not have 
user interface, a “V” may appear in the system tray. Also, the exit option 
is enabled, even if you select the Disable Exit option in the 
Administration > Agent Configuration > User Interface window.

— You can choose to deploy VitalAgent for Optivity on end-user desktops
that there is no end-user interface on the agent. If you select this option, 
the agent is completely hidden on the desktop. In this case there is no
logo, or other indication on the desktop that the agent is running.
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• Eudora Filtering

VitalAgent for Optivity may reduce the filtering speed of the Eudora e-ma
application.

• Termination After a Suspend and Resume on Windows 95 Laptop System

If you are running Microsoft Windows 95 on a laptop computer and you 
suspend and then resume the system, VitalAgent for Optivity may return 
internal error and terminate. This error has only been observed under certain
hardware and software configurations.

• Conflicts with Microsoft Loopback Adapter and VitalAgent IT for Optivity

If you have the Microsoft Loopback Adapter installed on your Windows N
server system, VitalAgent IT for Optivity only monitors File and Print traffi
To monitor all traffic on a Windows NT server system, disable the Loopba
Adapter. Refer to the Microsoft Windows NT server system documentatio
for details.

• RealAudio with Auto-Configuration

The RealAudio auto-configuration option attempts to use User Datagram
Protocol (UDP) at the transport. If your RealAudio application is configure
in this manner, VitalAgent for Optivity does not animate the RECV and 
SEND of data. VitalAgent for Optivity tracks RealAudio data only if the 
transport protocol is TCP or HTTP.

• Microsoft Remote Access Services (RAS) Servers

If you are using VitalAgent for Optivity on a Windows NT system designat
as a RAS server, the agent cannot gather data for calls made from the RA
server.

• HTTP 500-Series Errors (Internal Server Errors)

If you have a proxy server configured in your enterprise and VitalAgent fo
Optivity detects an HTTP 500-series error at the server you are trying to 
access, or at the proxy server, the agent identifies the error as an error at
proxy server.
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• Remote Modem Disconnect

When a remote modem disconnection occurs, VitalAgent for Optivity 
sometimes reports this situation as a normal disconnect, instead of as an

• Web Page or Site Visits

In rare cases, VitalAgent for Optivity may report visits to different Web pages 
and sites as a single visit if the visits occur in quick succession.

• Display Colors

If you are using VitalAgent for Optivity on a laptop computer that has an ol
color monitor and you are running other applications, the VitalAgent for 
Optivity display may not use the proper colors.

To work around this problem:

1. From the VitalAgent for Optivity menu, choose View > Preferences.

2. Click Colors.

3. Click the 16 color mode radio button.

4. Click OK.

Technical Publications

You can now print Nortel Networks technical manuals and release notes free, 
directly from the Internet. Go to support.baynetworks.com/library/tpubs. 
Find the Nortel Networks product for which you need documentation. Then loc
the specific category and model or version for your hardware or software prod
Using Adobe Acrobat Reader, you can open the manuals and release notes, 
for the sections you need, and print them on most standard printers. You can
download Acrobat Reader free from the Adobe Systems Web site, 
www.adobe.com.
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How to Get Help

If you purchased a service contract for your Nortel Networks product from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact one of the follow
Nortel Networks Technical Solutions Centers:

Technical Solutions Center Telephone Number

Billerica, MA 800-2LANWAN (800-252-6926)

Santa Clara, CA 800-2LANWAN (800-252-6926)

Valbonne, France 33-4-92-96-69-68

Sydney, Australia 61-2-9927-8800

Tokyo, Japan 81-3-5402-7041
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